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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking between IntelePeer and Avaya IP Office R9.0.1.

IntelePeer SIP Trunking provides PSTN access via a SIP trunk between a business site and the
IntelePeer network as an alternative to legacy analog or digital trunks. This approach generally
results in lower cost for the business customer.

IntelePeer is a member of the Avaya DevConnect Service Provider program. Information in
these Application Notes has been obtained through DevConnect compliance testing and
additional technical discussions. Testing was conducted via the DevConnect Program at the
Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedures for configuring Session Initiation Protocol (SIP)
Trunking between IntelePeer and Avaya IP Office R9.0.1.

In the sample configuration, the Avaya IP Office solution consists of an Avaya IP Office 500V2
running Release 9.0 SP1 software, Avaya Preferred Edition (a.k.a VVoicemail Pro) messaging
application, Avaya H.323 and SIP hard phones, and SIP-based Avaya softphones.

The IntelePeer SIP Trunking service provides PSTN access via a SIP trunk between a small business
site and the IntelePeer network as an alternative to legacy analog or digital trunks. This approach
generally results in lower cost for the business customer.

2. General Test Approach and Test Results

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to
the interoperability of the tested products and their functionalities. DevConnect Compliance Testing
is not intended to substitute full product performance or feature testing performed by DevConnect
members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of
a DevConnect member’s solution.

The general test approach was to configure a simulated business site using Avaya IP Office to
connect to the IntelePeer SIP Trunking service via the public Internet. The configuration shown in
Figure 1 was used to exercise the features and functionality tests listed in Section 2.1

2.1. Interoperability Compliance Testing

To verify SIP trunking interoperability, the following features and functionality were covered during
the compliance test.

e SIP OPTIONS queries and responses.

e Incoming PSTN calls to H.323 and SIP telephones at the business site. All inbound PSTN
calls were routed to the business site across the SIP trunk from the service provider.

e Outgoing PSTN calls from H.323 and SIP telephones at the business site. All outbound
PSTN calls were routed from the business site across the SIP trunk to the service provider.

e Various call types including: local, long distance, outbound toll-free, international, and

directory assistance.

G.711MU codec.

Caller ID presentation and Caller ID restriction.

DTMF transmission using RFC 2833.

Voicemail access and navigation for inbound and outbound calls.

Telephony supplementary features such as hold and resume, transfer, and conference.

Off-net call forwarding and call transfer/conference.

Twinning to PSTN mobile phones on inbound calls.

Use of SIP INVITE message for call redirection to the PSTN.
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T.38 fax.

Inbound and outbound long-duration call stability.

Inbound and outbound long holding time call stability.

Response to incomplete call attempts and trunk busy or error conditions.

Items not supported or not tested include the following:

e Inbound toll-free and emergency calls (911) were not tested as part of the compliance test.

e IntelePeer SIP Trunking does not support use of the SIP REFER method for network
redirection (transferring calls with the PSTN back to the PSTN).

e IntelePeer SIP Trunking does not support Operator call (0), Operator-Assisted (0 + 10-digit),
and Directory Assistance (411) calls.

2.2. Test Results

Interoperability compliance testing of IntelePeer SIP Trunking was completed with successful
results for all test cases with the exception of the observations/limitations described below.

e 200 OK" Contact Header — For outbound calls, the Contact header in the "200 OK"
message from IntelePeer to signal call connect contained the caller number instead of the
number for the actual connected party (i.e., the callee number). As a consequence, if the call
was terminated by the IP Office caller, the BYE message to IntelePeer would contain the
caller DID number in its Request URI instead of the PSTN callee number. The call would
terminate properly though the signaling was not clean as described. The same problem
existed with the “200 OK” response from IntelePeer to the session-refresh re-INVITE
messages from IP Office, with no negative impact observed. IntelePeer has been
investigating this issue.

e Codec Lockdown — For outbound calls with multiple codes offered in the SDP of outbound
INVITE, the call connect "200 OK" from IntelePeer contained the same set of codecs in the
SDP instead of just the preferred coded (first in the list).

e Session Refresh — IntelePeer did not initiate session refresh via SIP re-INVITE or UPDATE
messages, and no session refresh headers were contained in SIP messages from IntelePeer.
In the compliance test, session refresh for active calls was initiated from IP Office.

e T.38 Inbound Fax — At the end of the fax session, IP Office sent re-INVITE to IntelePeer
for switching back to the audio codec, to which IntelePeer responded with 488 Not
Acceptable Here". There was no negative impact on the fax session which terminated
properly.

e T.38 Outbound Fax — IntelePeer did not initiate re-INVITE to switch to T.38. IP Office
would fall back to G.711faxing (fax call treated as regular voice call with no guarantee for
success).

e Direct Media — Avaya IP Office R9.0 offers a new Direct Media capability on IP Office
500V2 that allows IP endpoints to send RTP media directly to each other rather than having
all the media flow through the IP Office, using up VolIP and relay resources. This capability
is not supported on the configuration described in these application notes where the Avaya
IP Office connects to the service provider network via a direct public Internet connection
without using an enterprise Session Border Controller.
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2.3. Support
Contact information for technical support on the IntelePeer SIP Trunking service:

e Email: support@intelepeer.com
e Telephone: (877) 780-8639

Avaya customers may obtain documentation and support for Avaya products by visiting
http://support.avaya.com. Alternatively, in the United States, (866) GO-AVAY A (866-462-8292)
provides access to overall sales and service support menus.

3. Reference Configuration

Figure 1 illustrates the test configuration showing a business site connected to IntelePeer SIP
Trunking.

Located at the business site is an Avaya IP Office 500V2 running the Release 9.0 SP1 software.
Endpoints include various Avaya IP Telephones (with H.323 and SIP firmware) and SIP-based
Avaya softphones (Avaya IP Office Video Softphone and Avaya Flare® Experience for Windows).
The site also has a Windows PC running Avaya Preferred Edition (a.k.a. Voicemail Pro) for
providing voice messaging service to the Avaya IP Office users, and Avaya IP Office Manager for
administering the Avaya IP Office.

Mobility Twinning is configured for some of the Avaya IP Office users so that calls to these user
phones will also ring and can be answered at the configured mobile phones.
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Figure 1: Test Configuration

For security purposes, any actual public IP addresses used in the compliance test were changed to
192.168.x.x throughout these Application Notes.
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For the purposes of the compliance test, users dialed a short code of 8 or 9, plus N digits to send
digits across the SIP trunk to IntelePeer. The short code (8 or 9) was stripped off by Avaya IP Office
but the remaining N digits were sent to the service provider network. For calls within the North
American Numbering Plan (NANP), the user dialed 11 (1 + 10) digits for long distance calls and
local calls. Thus, for these NANP calls, Avaya IP Office sent 11 digits in the Request URI and the
To header of an outbound SIP INVITE message. IntelePeer sent 10 digits in the Request URI and the
To header of inbound SIP INVITE messages.

In an actual customer configuration, the business site may also include additional network
components between the service provider and Avaya IP Office such as a Session Border Controller
or data firewall. A complete discussion of the configuration of these devices is beyond the scope of
these Application Notes. However, it should be noted that SIP and RTP traffic between the service
provider and Avaya IP Office must be allowed to pass through these devices.

The administration of the Avaya Preferred Edition (Voicemail Pro) messaging service and endpoints
on Avaya IP Office are standard. Since these configuration tasks are not directly related to the inter-
operation with the IntelePeer SIP Trunking Service, they are not included in these Application
Notes.

4. Equipment and Software Validated

The following equipment and software/firmware were used for the sample configuration provided:

Avaya Telephony Components

Equipment / Software Release / Version
Avaya IP Office 500V2 9.0.100.845
Avaya IP Office COMBO6210/ATM4 Module 9.0.100.845
Avaya IP Office Manager 9.0.100.845
Avaya Preferred Edition (a.k.a Voicemail Pro) 9.0.1.0.53
Avaya 1616 IP Telephones (H.323) Avaya one-X Deskphone 1.3 SP4
Avaya 9611G IP Telephones (H.323) Avaya one-X Deskphone

6.3.0.37_V452
Avaya 9630G IP Telephones (H.323) Avaya one-X Deskphone 3.2.1.2A
Avaya 1120E IP Telephone (SIP) 4.03.18.00
Avaya 1140E IP Telephone (SIP) 4.03.18.00
Avaya IP Office Video Softphone (Windows) 3.2.3.49 68975
Avaya Flare® Experience for Windows 1.1.4.23
IntelePeer Components

Equipment / Software Release / Version

Taqua T7100 Multimedia Controller 3.0.0.29

Testing was performed with IP Office 500V2, but this testing also applies to IP Office Server
Edition running the same version of software. Note that IP Office Server Edition requires an
Expansion IP Office 500V2 to support analog or digital endpoints or trunks.
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5. Configure Avaya IP Office

Avaya IP Office is configured through the Avaya IP Office Manager PC application. From the PC
running Avaya IP Office Manager, select Start - Programs - IP Office - Manager to launch
the application. A screen that includes the following in the center may be displayed:

WELCOME to IP Office Administration

What would you like to do ?

Create an Offline Configuration

Open Configuration from Swstem

Fead a Configuration from File

Select Open Configuration from System. If the above screen does not appear, the configuration
may be alternatively opened by navigating to File = Open Configuration at the top of the Avaya
IP Office Manager window. Select the proper Avaya IP Office system from the pop-up window and
log in with the appropriate credentials.

The appearance of the IP Office Manager can be customized using the View menu. In the screens
presented in this document, the View menu was configured to show the Navigation Pane on the left
side, omit the Group Pane in the center, and show the Details Pane on the right side. Since the Group
Pane has been omitted, its content is shown as submenus in the Navigation Pane. These panes
(Navigation and Details) will be referenced throughout the Avaya IP Office configuration. All
licensing and feature configuration that is not directly related to the interface with the service
provider (such as twinning and IP Office Softphone support) is assumed to already be in place.

In the sample configuration, Jersey City was used as the system name. All navigation described in
the following sections (e.g., License = SIP Trunk Channels) appears as submenus underneath the
system name Jersey City in the Navigation Pane. The configuration screens highlight
values/settings configured for the compliance test. Defaults were used for other values and may be
customized based upon requirements in the field.

AMC; Reviewed: Solution & Interoperability Test Lab Application Notes 7 0of 39
SPOC 3/14/2014 ©2014 Avaya Inc. All Rights Reserved. IntPSipTrkIPO9



5.1. Licensing and Physical Hardware

The configuration and features described in these Application Notes require Avaya IP Office to be
licensed appropriately. If a desired feature is not enabled or there is insufficient capacity, contact an
authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels License with sufficient capacity; click License in the
Navigation Pane. Confirm a valid license with sufficient Instances (trunk channels) in the Details

Pane. The screen below also shows the valid license for Avaya IP endpoints.

i Avaya IP Office Manager Jersey City [9.0.100.845] [Administrator{Administrator)]

File Edit View Tools Help

IP Offices

@& BOOTP (2)

Operator (3)

{4 Line (6)
-+ Control Unit {2)
()

@@ User (18)
[ 5§ Group (1)
(#-@% sShort Code (66)
B service (0)
s RAS (1)
) @ Incoming Call Route (21)
8 WanPort (0)
om Directory (0)
£ Time Profile (0)
) @ Firewall Profile (1)
[l P Route (4)
@y Account Code (0)
%
W& Tunnel {(0)
|- §3 User Rights (8)
¢ ARS (2)
@ RAS Location Request {0)
8 Location (0)

=

License | Remote Server
License Mode  License Mormal

PLDS Host ID 111311587034
Feature License Key Instances Status o) Add
| Report Viewer ‘ 255 Yalid
| Mobility Features o 255 Obsolete Remove
| IPSO0 Yoice Networking Channels - 255 valid
| IPS00 Yoice Metworking Channels - 4 valid
YCM Channel Migration - 255 Valid
|5IP Trunk Channels 255 Valid]
IPS00 Universal PRI {Additional chan... 255 Valid
| RAS LRQ Support (Rapid Response) - 255 Valid
| IP Office Dealer Support - Standard E... - 255 Valid
| IP Office Dealer Support - Profession... 255 valid
| 1P Office Distributor Support - Standa... 255 Valid
| IP Office Distributor Support - Profes... 255 Valid
| UMS Web Services 255 Yalid
| CCRSUP 255 valid
| Customer Service Agent 255 valid
| CCR Designer 255 Valid
| CCR CCCUPG 255 valid
| 1600 Series Phones 255 Yalid
| Third Party APT = 255 Valid
one-% Portal for IP Office 255 Valid
| Avaya IP endpoints 255 Valid |
| Customer Service Supervisor 255 valid B
| Essential Edition Additional Voicemail ... 255 Yalid
| Teleworker 255 Valid
| Mobile Worker 255 Yalid
| Power User 255 valid
| Advanced Edition 255 Valid v
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To view the physical hardware comprising the Avaya IP Office system, expand the components
under the Control Unit in the Navigation Pane. In the sample configuration, the second component
listed is a Combination Card. This module has 6 digital station ports, two analog extension ports, 4
analog trunk ports and 10 VCM channels. The VCM is a Voice Compression Module supporting
VoIP codecs. An Avaya IP Office hardware configuration with a VCM component is necessary to

support SIP trunking

To view the details of the component, select the component in the Navigation Pane.

The screen below shows the details of the IP 500 V2:

IP Offices

- R BOOTP (2)
[#4/ Operator (3)
) Jersey City
# %39 System (1)
#-F4 Line (6)
= Control Unit {2)
-
= 2 COMBOG210{ATM4
[#-4 Extension (17)
@ User(18)
3¢ Group (1)
[+ @% Short Code (66)
B service (0)
ol RAS (1)
3 e Incoming Call Route (21)
£8 wanPort (0)
o Directory (0)
£ Time Profile (0)
@ @ Firewall Profile (1)
& IP Route {4)
&g Account Code (0)

B IP 500 V2 =

| Unit

Device Number 1 \

Unit Type 1P 500 Y2

Version 9.0,100.845

Unit IP Address [10.32.128.30

|
[
Serial Number ot abis ‘
|
Interconnect Number ‘El ‘

|

Module Number :Control Unit

. License (64)

The screen below shows the details of the Combination Card:

IP Offices

®- & BOOTP(2)
¥4/ Operator (3)
(=% Jersey City
[#-#39 System (1)
#F4 Line ()
= Control Unit {2)
= 11PS00 V2
-
[+ 4 Extension (17)
@ User(18)
3¢ Group (1)
(- @% Short Code (66)
B service (0)
o RAS (1)
#- € Incoming Call Route (21)
£9 wanPort (0)
a4 Directory (0)
£ Time Profile (0)
& @ Firewall Profile (1)
- il IP Route (4)
& Account Code (0)

E COMBO6210/ATM4 £

| X | v|<]|

Unit
Device Number 2

Unit Type [coMBOBZ10{ATM4.

Version 9.0,100.845

Serial Number
Unit IP Address

Interconnect Number 0

Module Number féontroi Unit 1

W, License (64)
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5.2. System

This section configures the necessary system settings

5.2.1. System - LAN2 Tab

In the sample configuration, Jersey City was used as the system name and the WAN port (LAN2
port) was used to connect the Avaya IP Office to the public network. The LAN2 settings correspond
to the WAN interface on Avaya IP Office. To access the LAN2 settings, first navigate to System -
Jersey City in the Navigation Pane and then navigate to the LAN2-> LAN Settings tab in the
Details Pane. Set the IP Address field to the IP address assigned to the Avaya IP Office WAN port.

Set the IP Mask field to the mask used on the public network.

Ei

System | LANL | LANZ |DNS | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR | Twinning | ¥CM | CCR | Codecs

IP Offices

=)-#%9 System (1)
2 Jersey City
#-FH Line (6)
{#“=» Control Unit (2)
#-4 Extension (16)
#-§  User(18)
+-5¢ Group (1)
(# 8% Short Code (65)
B service (0)
o RAS (1)
- Incoming Call Route (19)
8 wanPort (0)
o Directory (0)
£ Time Profile {0)
@ Firewall Profile (1)
] 1P Route {(4)
@m Account Code (0)
., License (64)
W& Tunnel {0}
#-fq User Rights (8)
- ARS (2)
" RAS Location Request (0)
5 Location (0)

[ LAN Settings | yoIP || Network Topology

Jersey City™

IP Address |192 . 168 . 96 . 231 |
IP Mask 255 . 255 . 255 128
Primary Trans. IP Address | 0 0 0 0 |
Firewall Profile ‘7<7Non¢7>
RIP Mode None

[] Enable MaT

~

Number OF DHCP IP Addresses 200 &
DHCP Mode
O server O Client O Dialin  (®) Disabled

| v |

Advanced
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On the VoIP tab of LANZ in the Details Pane, configure the following parameters:

e Check the SIP Trunks Enable box to enable the configuration of SIP trunks.

e Inthe RTP section, the RTP Port Number Range can be customized to a specific range of
receive ports for the RTP media. Based on this setting, Avaya IP Office would request RTP
media be sent to a port in the configurable range for calls using LANZ2.

¢ Inthe Keepalives section, select RTP for Scope; select Enabled for Initial keepalives; enter
30 for Periodic timeout. These settings direct IP Office to send a RTP keepalive packet
starting at the time of initial connection and every 30 seconds thereafter if no other RTP
traffic is present. This facilitates the flow of media in cases where each end of the connection
is waiting for media from the other, as well as helping to keep firewall ports open for the
duration of the call.

Ko

= Jersey City £ | X | &« < |

| System | LANL | Lan2 DNS | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR || Twinning | ¥CM | CCR | Codecs |

LAM Settings | YoIP | Network Topalogy

~
H323 Gatekeeper Enable =
[] Auto-create Extn Auto-create User [[] H323 Remote Extn Enable
I SIP Trunks Enable
SIP Registrar Enable
[] auto-create ExtnjUser [] s1P Remote Extn Enable
Domain Name \
o —
LDP UDP Port 5060 $|  RemoteUDPPort |
Layer 4 Protocol TCP TCP Port 55050 ?; Remote TCP Port ‘ ] ‘
s TLS Port §5061 |  Remote TLSPort |
Challenge Expiry Time {secs) :10 =
RTP 5
Port Number Range
Minimum 49152 3| Maximum 53246 3|
Port Mumber Range (NAT)
Minimunn Hots2 G| Maximum 53246 3|
Enable RTCP Monitoring on Port 5005
Keepalives
Scope RTP v | Periodic timeout 130 ‘
Initial keepalives 1Enab!ed v 1
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Scroll down to the DiffServ Settings section. Avaya IP Office can be configured to mark the
Differentiated Services Code Point (DSCP) in the IP Header with specific values to support Quality
of Services policies for both signaling and media. The DSCP field is the value used for media and
the SIG DSCP is the value used for signaling. The specific values used for the compliance test are
shown in the screen below and are also the default values. For a customer installation, if the default
values are not sufficient, appropriate values should be provided by the customer.

= Jersey City £ | X | v | < |
| System | LANL ‘ Lan2 |DNS | Voicemail | Telephony | Directory Services | System Events;‘“SMTP | SMDR | Twinning | ¥CM | CCR | Codecs |
LAN Settings | YOIP | Network Topology .
‘ Enable RTCP Monitoring on Port S005 Al
Keepalives
Scope ;RTP 1 vi Periodic timeout \30
Initial keepalives fAEnabIed v :
| | DiffServ Settings
(1l 4 : s : \ 5 =
B8 |$ \ DSCP(Hex) B8 & | video DSCP{Hex) [FC < \ DSCP Mask {(Hex) }88 % | SIGDSCP (Hex)
46 2| psce 46 3| videoDscP 63 2| pscpmask 3 3| siepsce
DHCP Settings
Primary Site Specific Option Number (SSOM) 176 5 ‘
Secondary Site Specific Option Mumber (SSON) 242 (.:’
VLAN Mok Present v “
1100 Voice YLAN Site Specific Option Number (SSON) 232 31
1100 Voice YLAN IDs
AMC; Reviewed: Solution & Interoperability Test Lab Application Notes 12 of 39
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On the Network Topology tab of LAN2 in the Details Pane, configure the following parameters:

e Select Firewall/NAT Type from the pull-down menu that matches the network
configuration. No firewall or network address translation (NAT) device was used in the
compliance test as shown in Figure 1, so the parameter was set to Open Internet. With the
Open Internet setting, STUN Server IP Address is not used.

e Set Binding Refresh Time (seconds) to a desired value. This value is used as one input to
determine the frequency at which Avaya IP Office will send SIP OPTIONS messages to the
service provider. See Section 5.9 for complete details.

e Set Public IP Address to the IP address of the Avaya IP Office WAN port.

e Set Public Port to 5060 for UDP.

=Y Jersey City” - | X[ v]|<|

| System | LaNL | LANZ |DNS || Yoicemai | Telephony | Directory Services | System Events | SMTP | SMDR | Twinning | ¥CM | CCR | Codecs
LAN Settings | voIP | Network Topology |
Metwork Topology Discovery

STUN Server Address [ : STUNPort 3478 -]
Firewall/NAT Type Ebpen Internet ¥
Binding Refresh Time (seconds) ?'377 3
Public IP Address (192 168 . 9 . 231 | Cancel
Public Port
LDP 5060 :
TCP o El
TLS 0 *

[] run STUN on startup

During the compliance testing, the LANL1 interface was used to connect the Avaya IP Office to the
business site IP network. The LANL1 interface configuration is not directly relevant to the interface
with IntelePeer, and therefore is not described in these Application Notes.
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5.2.2. System - Voicemail Tab

In the VVoicemail tab of the Details Pane, configure the SIP Settings section. The SIP Name and
Contact are set to one of the DID numbers assigned by IntelePeer. The SIP Display Name (Alias)
parameter can optionally be configured with a descriptive name. Uncheck the Anonymous box to allow
the VVoicemail Caller ID information to be sent to the network.

= Jersey City & | X | v | = |

| System | LAN1 | LANZ | DNS :Voicemail Telephony | Directory Services | System Events | SMTP | SMDR || Twinning | YCM CCR Codecs

Voicemail Type Woicemail Lite/Pro v i [[] Messages Button Goes To Visual Yoice

Yoicemail Destination

Voicemail IP Address { 10 . 32 128 787‘

Backup Voicemail IP Address } 0 0 0 0 !

Voicemail Channel Reservation

Unreserved Channels  |237

2 |

Auto-Attendant 2 Yoice Recording 5 $ ‘ Mandatory Yoice Recording 3 3 |
Announcements 5 2 | Mailbox Access |5 % }
DTMF Breakout
Reception | Breakout {DTMF 0) ‘ v ;
Breakout (DTME 2) v
Breakout (DTMF 3) ‘ v !
SIP Settings
SIP Name 7207291059 |
SIP Display Name (Alias) i%icema'iir 71
Contact 7207291059 \
Anonymous ]
Call Recording
Auto Restart Paused Recording (secs) |15 =
Hide Auto Recording O
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5.2.3. System - Telephony Tab

Navigate to the Telephony = Telephony tab on the Details Pane. Enter or select 0 for Hold
Timeout (secs) so that calls on hold will not time out. Choose the Companding Law typical for the
business site. For the compliance test, U-LAW was used. Uncheck the Inhibit Off-Switch
Forward/Transfer box to allow call forwarding and call transfer to the PSTN via the service
provider across the SIP trunk per customer business policies. Note that this configuration might pose
a security issue (Toll Fraud). Customers should exercise caution with this configuration.

P
-
-

| System | LAN1 | LAMZ | DMS

Jersey City

I | >

| v | < |

Voicemail} Telephony | Directory Services | System Events | SMTP | SMDR. | Twinning | YCM CCR Codecs

‘ Telephony ‘Park&Page Tones & Music | Ring Tones | SM Call Log || TUL
-~ |
Analogue Extensions Companding Law —,
| Switch Line
Default Outside Call Sequence | Mormal v
Default Inside Call Sequence ;ﬁing Type 1 - | ® U-Law ® U-Law Line
Default Ring Back Sequence 3ﬁing Type 2 v
7 5 O A-Law O A-Law Line
Restrict Analogue Extension Ringer Yoltage O
|
| Dial Delay Time {secs) 4 = [] pss status
‘ Dial Delay Count 0 - } Auto Hold
Default No Answer Time (secs) 115 = ‘ Dial By Haime
¥| sh
\ IHoId Timeout (secs) 0 ~ H Show Account Code
| 5 2
B @l Inhibit OFf-Switch Forward{Transfer
Park Timeout (secs) 300 i | 0 / I
] E] Restrict Network Interconnect
Ring Delay (secs) S =]
e — [T] orop External Only Impromptu Conference
Call Priority Promotion Time (secs) |Disabled &
= — [] visually Differentiate External Call
Default Currency |UsD ¥
= ——— [ unsupervised Analog Trunk Disconnect Handling
Default Name Priority | Favor Trunk v
‘ High Quality Conferencing
Media Connection Preservation | Disabled v
— D Strict SIPS
Digital/Analogue Auto Create User R
L — |
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5.2.4. System - Twinning Tab

To view or change the System Twinning settings, navigate to the Twinning tab in the Details Pane
as shown in the following screen. The Send original calling party information for Mobile

Twinning box is not checked in the sample configuration, and the Calling party information for
Mobile Twinning is left blank.

-

= Jersey City (] |t [ sl

| System | L&AN1 | LANZ | DNS | Yoicemail | Telephony | Directory Services | System Events | SMTP | SMDR ‘ Twinning |YCM | CCR | Codecs

[] send original calling party information For Mobile Twinning

Calling party information for |
Mobile Twinning L

5.2.5. System — Codecs Tab

In the Codecs tab of the Details Pane, select or enter 101 for RFC2833 Default Payload. This setting
was recommended by IntelePeer for use with out-band DTMF tone transmissions.

Ko
-

= Jersey City £ || |
| System | LAN1 | LANZ | DNS Voicemail | Telephony || Directory Services | System Event§ | SMTP | SMDR | Twinning | YCM CCR ‘ Codecs |
RFC2833 Default Payload {101 ]

Available Codecs Default Codec Selection

: Unused Selected

G711 ULAW 64K == G.711 ULAW 64K

G.711 ALAW 64K G.711(AI).AW 64K

G.729(a) 8K CS-ACELP

D G.722 64K G.723.1 6K3 MP-MLQ

G.729(a) 8K C5-ACELP 7%

G.723.1 6K3 MP-MLQ

=5
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5.3. IP Route

Navigate to IP Route - 0.0.0.0 in the left Navigation Pane if a default route already exists.
Otherwise, to create the default route, right-click on IP Route and select New (not shown).
Create/verify a default route with the following parameters:

e Set IP Address and IP Mask to 0.0.0.0.
e Set Gateway IP Address to the IP address of the gateway for the public internet WAN

network.

e Set Destination to LAN2 from the drop-down list.

IP Offices

- R BOOTP(2)
[#¢/# Operator (3)

57 =
[+ -4 Extension (16)
#§ User(18)
# 5¢ Group (1)
[+ 8% Short Code (65)
B service (0)
o, RAS (1)
P Incoming Call Route (19)
2 wanPort (0)
o Directory (0)
£ Time Profile (0)
& @ Firewal Profile (1)
= 1P Route (4)
El 0.0.0.0
KA 10.32.0.0
KAl 152.165.0.0
192.168.99.0
& Account Code (0)

7

0.0.00°

| 1PRoute |

IP Address { 0 0 0 0|
IP Mask [€« 0« 0 D |
Gateway IP Address [192 168 . 96 . 254 |
Destination |Lanz

Metric

o

[] proxy aRP

A I

_<>i <
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5.4. Administer SIP Line

A SIP Line is needed to establish the SIP connection between Avaya IP Office and the IntelePeer
SIP Trunking service. The recommended method for configuring a SIP Line is to use the template
associated with these Application Notes. The template is an .xml file that can be used by IP Office
Manager to create a SIP Line. Follow the steps in Section 5.4.1 to create the SIP Line from the
template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

e |P addresses

e SIP Credentials (if applicable)

e SIP URI entries

e Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary after
the SIP Line is created via the template. The resulting SIP Line data can be verified against the
manual configuration shown in Sections 5.4.2.

Also, the following SIP Line settings are not supported on Avaya IP Office Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls
e Transport — Second Explicit DNS Server
e SIP Credentials — Registration Required

5.4.1. Create SIP Line From Template

1. Copy the template file to the computer where IP Office Manager is installed. Rename the
template file to US_ IntelePeer_SIPTrunk.xml. The file name is important in locating the
proper template file in Step 5.

2. Verify that template options are enabled in IP Office Manager. In IP Office Manager,
navigate to File = Preferences. In the IP Office Manager Preferences window that appears,
select the Visual Preferences tab. Verify that the option box is checked next to Enable
Template Options. Click OK.

K4l 1P Dffice Manager Preferences @@
Preferences | Directories | Discovery | Visual Preferences | security || walidation

Icon Size |Small w
Mulkiling Tabs
Enable Template Options

) [ o [ e [ v ]
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3. Import the template into IP Office Manager. From IP Office Manager, select Tools =
Import Templates in Manager. This action will copy the template file into the IP Office
template directory and make the template available in the IP Office Manager pull-down
menus in Step 5. The default template location is C:\Program Files\Avaya\lP
Office\Manager\Templates.

"} Avaya IP Office Manager Jersey City [9.0.100.845] [Administrator)

File  Edit Yiew TooIs‘I Help

3 A | _§| Extension Renumber...

Line Renumber...
IP Offie

% Connect To...
&= BOOTP (2)
#-¢7 Operator (3) B ¥ :
(== Jersey City SCN Service User Management | Yoicemail
=)-#39 System (1) . T e
= Jersey Busy on Held Yalidation
BT Linei(6) MSN Configuration 10
[+ <= Control Unit
[+ -4 Extension (1 : B3z Vess ( i
® & User(18) I Import Templates in Manager |!:rvation
g Group (1) i
[+ §% Short Code (66) Unreserved Channels (237 |
@B service (0) —
& ol RAS(1) Auto-Attendant 2 | void
€@ Incoming Call Route (21) o E__® wal

In the pop-up window (not shown) that appears, select the directory where the template file
was copied in Step 1. After the import is complete, a final import status pop-up window (not
shown) will appear stating success or failure. Click OK (not shown) to continue. If preferred,
this step may be skipped if the template file is copied directly to the IP Office template
directory.
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4. To create the SIP Trunk from the template, right-click on Line in the Navigation Pane, then
navigate to New - New SIP Trunk From Template.

IP Offices SIP Line -Line 17

@ K BOOTP (2) | SIP Line [Transport | SIP LRI VoIP | 138 Fax| SIP Credentials
[#-¢% Operator (3) } 2 B : = .
(=529 Jersey|+ Mew 5 -
o Syl A H323 Line
@ T4 L <9 Generate SIP Trunk Template IP DECT Line
&-<= Co SIP Line
W& Exl & Cut Chri+x
& Us{ > SM Line L
B8 UsiZyl copy Ctri+C ‘
g Gr , . SIP DECT Line :
sty R, 5 I Mew SIP Trunk From Template JJ
@B 5ef X | Delete Ctrl+Del
% ol RA + Validate ’. |
# P Ing ‘ .
£ ws Rnec ' \ \
s Dir Mew from Template (Binar
£ Ti et 7 \Diversion Header v ‘
ol TN . 2 & *
24 @ Fir Export as Template (Binary) :
%“ T ASSUCIEUOTT e O [BV Source IP address v
# IP Route {(4) =]
#m Account Code (0)
&, License (64) ‘

5. In the subsequent Template Type Selection pop-up window, select United States from the
Country drop-down list and select IntelePeer from the Service Provider drop-down list as
shown below. These values correspond to parts of the file name
(US_IntelePeer_SIPTrunk.xml) created in Step 1. Click Create new SIP Trunk to finish
creating the trunk.

a Template Type Selection

Locale
Country ‘ United States v i
Service Provider \r: l [] Display &l

[ Create new SIP Trunk ] [ Cancel J

Note that the newly created SIP Line may not immediately appear in the Navigation pane
until the configuration was saved, closed and reopened in IP Office Manager.

6. Once the SIP Line is created, verify the configuration of the SIP Line with the configuration
shown in Sections 5.4.2.
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5.4.2. SIP Line-=SIP Line Tab

To manually create a SIP line, begin by navigating to Line in the Navigation Pane. Right-click and
select New - SIP Line (not shown). On the SIP Line tab in the Details Pane, configure the
parameters as shown below.

e Set ITSP Domain Name to the LANZ2 IP address (192.168.96.231) so that Avaya IP Office
uses this IP as the URI host in SIP headers such as From and Diversion.

e Check the In Service box.

e Check OOS box. Avaya IP Office will use the SIP OPTIONS method to periodically check
the SIP Line. See Section 5.9 for details on time interval between SIP OPTIONS sent by IP
Office.

e Set Call Routing Method to Request URI. Avaya IP Office will route inbound calls based
on the number in the Request URI.

e Set Send Caller ID to Diversion Header. With this setting and the related configuration in
Section 5.2.4, Avaya IP Office will include the Diversion Header for calls that are redirected
via Mobile Twinning out the SIP Line to the service provider. It will also include the
Diversion Header for calls that are forwarded out the SIP Line..

e Uncheck REFER Support. IntelePeer SIP Trunking does not support use of REFER for off-
net call re-direction as in call transfer.

e Set Method for Session Refresh to Auto. With this setting Avaya IP Office will send

UPDATE messages for session refresh if the other party supports UPDATE. If UPDATE is
not supported, re-INVITE messages are sent.

IP Offices Ei

SIP Line - Line 17° k¥ X vl<]|>

®=- R BOOTP(2)
[#-4/# Operator (3)

i+ [§l P Route (4)
&m Account Code (0)
W License (64)
W% Tunnel (0)
- fq User Rights (8)
- ARS (2)
" RAS Location Request (0)
#5 Location {0)

SIP Line |Transport| SIP URI|VoIP | T38 Fax | SIP Credentials

[C] REFER Support

I Method for Session Refresh

Auto

Session Timer (seconds)

On Demand

Media Connection Preservation | Disabled

<>

=% Jersey City Line Number 17 ¥
(#9539 System (1)
=7 Line (6) IITSP Domain Name 192.168.96.231 I I In Service I
11
112 URI Type SIP v
13 >
t v
£ 4 Prefix |Check 003 |
. 17 Mational Prefix |Ca|l Routing Method Request URI v
", 18
S ' . Originator number for
i Contro! Unit (2) Country Code forwarded and twinning calls
[+ 4 Extension (16) =5 oo g . - A —
= a User {18) International Prefix MName Priority | System Default v
# Group (1) - = o
el 2 Shart Code (65) | Send Caller ID Diversion Header v Caller ID from From header  []
@ service (0) Association Method By Source IP address v Send From In Clear O
o RAS (1)
[+ Q Incoming Call Route (19) Userd-ngent and Server
£8 wanPart (0) Headers ,
o~ Directory (0} Service Busy Response 486 - Busy Here v
£17 Time Profile (0)
® @ Firewall Profile (1) Action on CAC Location Limit | allow Yoicemail N
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5.4.3. SIP Line — Transport Tab
Navigate to the Transport tab and set the following:

e Setthe ITSP Proxy Address to the IP address of the service provider SIP Trunking access
interface provided by IntelePeer.

e Setthe Layer 4 Protocol to UDP.

e Set Use Network Topology Info to LAN2 as configured in Section 5.2.1.

e Set the Send Port to 5060.

SIP Line -Line 17°

SIP Line| Transport |SIP URI|WoIP || T38 Fax| SIP Credentials

ITSP Proxy Address |192.168.123.104

Metwork Configuration

Layer 4 Protocol |UDP v Send Port  |S060 il
Use Network Topology Info  |LAN 2 v

Explicit DNS Server(s) | O 0 0 o ||o 0 0 o |

Calls Route via Registrar

Separate Reqgistrar

5.4.4. SIP Line — SIP URI Tab

Select the SIP URI tab to create a SIP URI entry or edit an existing entry. A SIP URI entry matches
each incoming number that Avaya IP Office will accept on this line. Click the Add button and the
New Channel area will appear at the bottom of the pane. For the compliance test, a single SIP URI
entry was created to match any DID number assigned to Avaya IP Office users. The following
screen shows the edit window on a previously configured entry for the compliance test.

e Set Local URI to Use Internal Data. This setting allows calls on this line whose SIP URI
matches the SIP Name set on the SIP tab of any User as shown in Section 5.6.

e Set Contact and Display Name to Use Internal Data. This setting will cause the Contact
and Display Name data to be set from the corresponding fields on the SIP tab of the
individual User as shown in Section 5.66.

e Set PAI to None. This setting directs Avaya IP Office to send the PPI (P-Preferred-Identity)
header when appropriate instead of the PAI header (P-Asserted-Identity). The PPI header
will be populated from the data set in the SIP tab of the call initiating User as shown in
Section 5.66.

e For Registration, select 0:<None> from the pull-down menu. The test circuit used for the
compliance test did not require trunk registration.
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e Associate this line with an incoming line group by entering line group number in the
Incoming Group field. This line group number will be used in defining incoming call routes
for this line. Similarly, associate the line to an outgoing line group using the Outgoing
Group field. For the compliance test, the incoming and outgoing group 17 was specified
(Note: In the sample configuration, the line group number happened to be identical to the SIP
Line number, but these two numbers do not need to be the same).

e Set Max Calls per Channel to the number of simultaneous SIP calls allowed using this SIP

URI pattern.
= SIP Line - Line 17 ek -# X[ vl<]|>
|sIP VlfinVeMTranrsport; SIP URI ifv‘oIP |T38 Fax| SIP Credent»ials’
| Channel Groups Via Local URI Contact Display Name = PAI ‘ Add...
[ 1 17 17 ) i M.
Remove
| Edit...
‘ Edit Channel ‘
Via 1135.10.96.231 D
|Local LRI Use Internal Data ; vI
Songect [Lss Instoe Deta [
Display Name jUse Internal Data v
IPAI jNone v I
IRegistration |0: <Mone> v
Incoming Group }7
Qutgoing Group ]rl?
Max Calls per Channel 10| & |
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5.4.5. SIP Line — VoIP Tab
Select the VoI P tab. Set the parameters as shown below.

e Set the Codec Selection to Custom.

e Choose G.711 ULAW 64K and G.729(a) 8K CS-ACELP from the Unused box and move
these two selections to the Selected box. Use the up and down arrows in the middle to order
these 2 codes as shown. The G.711MU and G.729A codecs are supported by IntelePeer SIP
Trunking.

e Select T38 for Fax Transport Support.

e Set the DTMF Support field to RFC2833. This directs Avaya IP Office to send DTMF
tones as out-band RTP events as per RFC2833.

e Uncheck the VoIP Silence Suppression option box.

e Check the Re-invite Supported option box.

e Check the PRACK/100rel Supported option box. This setting enables support by Avaya IP
Office for the PRACK (Provisional Reliable Acknowledgement) message on SIP trunks.

=] SIP Line - Line 17 ek-M|X|vl<]|>

SIP Line| Transport |SIP URI| YoIP 138 Fax| SIP Credentials

I D VoIP Silence Suppression l

E - Allow Direct Media Path
|Codec Selectiod |Sostan 2] | Re-invite Supported |

Unused Selected

(G711 ALAW 64K =» | [6.711 ULaw B4k [] Codec Lockdown

|G723.1 6K3 MP-MLQ .729(a) 8K CS-ACELP | PRACK/100rel Supported |

\

| Force direct media with phones

‘ S5 G.711 Fax ECAN

>3

Fax Transport Support iT38 v |
Location ‘ Cloud ™ ‘
Call Initiation Timeout (s) 5 3
DTMF Support RFC2833 v
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5.4.6. SIP Line —T38 Fax Tab

Select the T38 Fax tab to set the Fax over Internet Protocol parameters of the SIP Line. Set the
parameters as shown below.

e Uncheck Use Default Values at the bottom of the screen.

e Set T38 Fax Version to 0. IntelePeer SIP Trunking supports T.38 fax version 0.

e Set Max Bit Rate (bps) to 14400, the highest fax bit rate that Avaya IP Office supports for
T.38 faxing.

e Check the Disable T30 ECM option.

e Default values may be used for all other parameters.

= SIP Line -Line 17 k- X|v|l<]|>

SIP Line/| Transport |SIP URI voIP | T38 Fax iSIF' Credentials

‘ I T35 Fax Version 10 v “ I

Scan Line Fix-up
Transport TFOP Enhancement
edorkiey [ — [# pisable T30 ECM |
Letcnee: 0777" [] Disable EFlags For First DIS
High Speed ;077 ;J [] pisable T30 MR Compression
TCF Method ’T‘rans TCF ‘ZJ [] nsF override
Max Bit Rate {(bps) ‘ 14400 v 1 I ‘7 J

b 2]

<>

EFlag Start Timer (msecs) ‘2600

EFlag Stop Timer {msecs) 12300 3}
Tx Network Timeout {secs) ‘200 ﬂ
j |D Use Default Yalues
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5.5. Short Code

Define a short code to route outbound calls to the SIP Line. To create a short code, right-click on
Short Code in the Navigation Pane and select New (not shown). On the Short Code tab in the
Details Pane, configure the parameters as shown below:

e Inthe Code field, enter the dial string which will trigger this short code, followed by a semi-
colon. The 9N; short code, used for the compliance test, will be invoked when the user dials
9 followed by any number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to N”@192.168.123.104”. This field is used to construct the
Request URI and To headers in the outgoing SIP INVITE message. The value N represents
the number dialed by the user. The IP address following the @ sign is the IP address of the
IntelePeer SIP Trunking access interface.

e Setthe Line Group Id to the Outgoing Group number defined on the SIP URI tab on the
SIP Line in Section 5.4.4. This short code will use this line group when placing the outbound
calls.

IP Offices 9N;: Dial* ek -8 X|wv <>

% R BOOTP (2) Short Code
#-¢/ Operator (3)
(=52 Jersey City Code 9N;
[#-“%p System (1)
# T4 Line (6)
@<= Control Unit (2) Telephone Mumber  |N'@192.168.123.104"
4 Extension (17) — =
@ § User(18) Line Group ID 17 v|
(5§ Group (1) —
= 9x Locale United States {(LUS English) v
@ service (0) Force Account Code  []
o, RAS (1)
P Incoming Call Route (21)
£8 wanPart (0)
a4 Directory (0)
£ Time Profile (0)
@ Firewall Profile (1)
# IP Route (4)
@y Account Code (0)
. License (64)
W& Tunnel (0)
@ f3 User Rights (8)
- ARS (2)
& RAS Location Request {0}
5 Location (0)

Feature Dial v
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The simple 9N; short code illustrated above does not provide a means of alternate routing if the
configured SIP Line is out of service or temporarily not responding. When alternate routing options
and/or more customized analysis of the dialed digits following the short code are desired, the Automatic
Route Selection (ARS) feature may be used. In the screen below, the short code 8N; is illustrated for
access to ARS. When the Avaya IP Office user dials 8 plus any number N, rather than being directed to a
specific Line Group Id, the call is directed to 50: Main, configurable via ARS. See Section 5.8 for
example ARS route configuration.

E 8N;: Dial k- X|v|<]|>

Short Code
Code |BN;
Feature :Dial v |

Telephone Number M

Line Group ID ;50: Main v |

Locale v

Force Account Code  []

Optionally, add or edit a short code that can be used to access the SIP Line anonymously. In the
screen shown below, the short code *67N; is illustrated. This short code is similar to the 9N; short
code except that the Telephone Number field begins with the letter W, which means “withhold the
outgoing calling line identification”. In the case of the compliance test, when a user dialed *67 plus
the number, Avaya IP Office would include the user’s telephone number (DID number assigned to
the user) in the P-Preferred-ldentity (PPI) header and would include the Privacy: id header in the
outbound INVITE message. Consequently IntelePeer would prevent presentation of the caller id to
the called PSTN destination.

*67N;: Dial® e -8 I X v <>
Short Code |
Code *67N;
Feature qu! e

Telephone Number | WN'@192.168.123.104"

Line Group ID 17 v

Locale v

Force Account Code I:]

AMC; Reviewed: Solution & Interoperability Test Lab Application Notes 27 of 39
SPOC 3/14/2014 ©2014 Avaya Inc. All Rights Reserved. IntPSipTrkIPO9



5.6. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP Line
defined in Section 5.4. To configure these settings, first navigate to User->Name in the Navigation
Pane, where Name is the name of the user to be modified. In the example below, the name of the
user is Jim 1120E. Select the SIP tab in the Details Pane. The SIP Name and Contact are set to one
of the DID numbers assigned by IntelePeer. The SIP Display Name (Alias) can optionally be
configured with a descriptive text string. The value entered for the Contact field will be used in the
Contact header for outgoing SIP INVITE to the service provider. The value entered for the SIP
Name is used as the user part of the SIP URI in the From header for outgoing SIP trunk calls.

If outbound calls involving this user and a SIP Line should be considered private, then the
Anonymous box may be checked to withhold the user’s information from the network (or
alternatively use the *67 short code as defined in Section 5.5).

IP Offices B Jim 1120E: 258 ek -E I X vi<l>

@R BOOTP (2)
[#-¢7 Operator (3)
(=% Jersey City

User | Yoicemail | DND | Short Codes | Source Numbers | Telephony | Forwarding || Dial In | Voice Recording | Button Programming
Menu Programming | Mobility | Group Membership Announcements | SIP Personal Directory |

@ System (1) SIP Name 7207201054

#-F4 Line (6) e

(#-<=» Control Unit {2) SIP Display Mame (Alias) |Jim 1120E

¥4 Extension (17) =

=) a User (18) Contact ?207291054
g Mouser

§rg RemoteManager
251 Allan 9630

| 201 Extn201

' 202 Extn202

| 203 Extn203

| 204 Extn204

205 Extn20S

' 206 Extn206

207 Extn207

| 208 Extn208

252 James 1616

-

e 253 John Softphone

e 259 Juan FlareWin

e 255 RW FlareWwin

e 257 Taili 1140E

| 256 Tony 9611

5§ Group (1)

[+ 8% Short Code (66)

[T anonymous

The following screen shows the similar SIP settings for an analog extension user for fax:

X

= Extn208: 208 - X|vl<]>

User | Voicemail | DND | Short Codes | Source Mumbers | Telephony | Forwarding || Dial In | Yoice Recording | Button Programming
Menu Programming | Mobility | Group Membership Announcementsj SIP | Personal Directory

SIP Name 7207291053
SIP Display Name (alias) |Extn208 FAX

Contact 7207291053

[[] anonymous
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5.7. Incoming Call Route

An incoming call route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by the service provider. To create
an incoming call route, right-click Incoming Call Route in the Navigation Pane and select New (not

shown). On the Stan

dard tab of the Details Pane, enter the parameters as shown below:

e Set the Bearer Capacity to Any Voice.

e Setthe Line Group Id to the Incoming Group of the SIP Line defined in Section 5.4.4.

e Set the Incoming Number to the incoming DID number on which this route should match.
Matching is right to left.

IP Offices

- & BOOTP (2)

[#¢# Operator (3}

(=% Jersey City

) System (1)

{4 Line (6)

= Control Unit {2)

[+ -4 Extension (17)

# @ User(18)

#-5¢ Group (1)

[+ @3 Short Code (66)
B service (0)

o RAS (1)

= e Incoming Call Route (15)

@

@ 17 7207291053
@
@ 17 7207291055
@ 17 7207291056
@ 17 7207291059

=] 17 7207291054 eh-E I Xlvi<l>

| standard | yeice Recording | Destinations

Bearer Capability : Any Voice v 1
Line Group ID i” v ‘
Incoming Mumber |7207291054 }

Incoming Sub Address ‘ i

Incoming CLI ‘7 \
Locale gnltedstates (US Engllih) jv \
R ~
Tag \ ‘
Hold Music Source i_System Source v i
Ring Tone Override ;None v ‘

On the Destinations

tab, select the destination from the pull-down list of the Destination field. In

this example, incoming calls to 1-732-992-4656 on Incoming Group 17 are to be routed to the user
“Jim 1120E” at extension 258.

X —

= 17 7207291054 g -E X v <>
Standard | Yoice Recarding | Destinations |

TimeProfile Destination Fallback Extension |
» Default Yalue 258 Jim 1120E v v |

The screen below shows incoming call to 1-720-729-1059 mapped to the voice messaging service:

X —

= 17 7207291059 ek -8 X vl<]>
| Standard | Yoice Recording | Destinations ‘7
TimeProfile Destination Fallback Extension |
14 Default Value YoiceMail v v|
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5.8. ARS and Alternate Routing

While detailed coverage of Automatic Route Selection (ARS) is beyond the scope of these Application
Notes, this section includes basic ARS screen illustration and considerations. ARS is shown here mainly
to illustrate alternate routing should the SIP Line be out of service or temporarily not responding.

Optionally, ARS can be used to supplement or replace the simple 9N; short code approach documented
in Section 5.5. With ARS, secondary dial tone can be provided after the access code, time-based routing
criteria can be introduced, and alternate routing can be specified so that a call can re-route automatically
if the primary route or outgoing line group is not available. ARS also facilitates more specific dialed
telephone number matching, enabling immediate routing and alternate treatment for different types of
numbers following the access code. For example, if all local and long distance calls should use the SIP
Line, but service numbers should prefer a different outgoing line group, ARS can be used to distinguish
between the two call patterns.

To add a new ARS route, right-click ARS in the Navigation Pane and select New (not shown). To view
or edit an existing ARS route, expand ARS in the Navigation Pane and select a route name.

The following screen shows an example ARS configuration for the route named 50: Main. The In
Service parameter refers to the ARS form itself, not the Line Groups that may be referenced in the form.
If the In Service box is un-checked, calls are routed to the ARS route name specified in the Out of
Service Route parameter. IP Office short codes may also be defined to allow an ARS route to be
disabled or enabled from a telephone. The configurable provisioning of an Out of Service Route and the
means to manually activate the Out of Service Route can be helpful for scheduled maintenance or other
known service-affecting events for the primary route.

IP Offices Ei Main® ek-E X vi<l|>

#- & BOOTP(2) ARS
#-¢/ Operator (3) -
(=-%2y Jersey City ARS Route Id Secondary Dial tone
b %% System (1) ’ 5 =
I+ T4 Line {6) Route Name ‘ SystemTone M|
)<= Control Unit (2) i
& Extension (17) Dial Delay Time System Default (4) = Check User Call Barring
| @ User(18)
| 5% Group (1)
|- @% Short Code (66)
B service (0)
o, RAS (1) l
| @9 Incoming Call Route (15) )
@ ‘WanPort {0} Time Profile — QUL Of Hours Route <None> v
= Directory (0) l )
£ Time Profile (0)

& @ Firewall Profile (1) T
+ [l IP Route (4) | Code Telephone Number Feature Line Group ID
#m Account Code (0) 911 911 Dial Emergency [1]
. License (64) H; N'@192.168.123,104" Dial 17 Remove
W& Tunnel (0)
# § User Rights (8)
= ¢ ARS (2)
o0 tain
"¢ 51: backup
" RAS Location Request (0} I
5 Location (0) l

L S5 S S

In Service Out of Service Route S1: backup v

&

o)

Edit...

Alternate Route Priority Level |3 v |

I |

Alternate Route Wait Time 30 4 | ey Alternate Route |51: backup v
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Assuming the primary route is in-service, the number passed from the short code used to access ARS
(e.g., 8N; in Section 5.5) can be further analyzed to direct the call to a specific Line Group ID. Per the
example screen above, if the user dialed 8-911, the call would be directed to Line Group 0 to be sent out
to the local area emergency response center (note that a short code 911 can also be configured to send the
emergency call out when the user simply dials 911). If the user dialed 8 + any other number, the call
would be directed to Line Group 17 as configured in Section 5.4.4. If the primary route cannot be used,
the call can automatically route to the route name specified in the Alternate Route field in the lower
right of the screen (51: Backup). Since alternate routing is considered a privilege not available to all
callers, IP Office can control access to the alternate route by comparing the calling user’s priority,
configured in the User tab of individual users, to the value in the Alternate Route Priority Level field.

5.9. SIP Options

Avaya IP Office sends SIP OPTIONS messages periodically to determine if the SIP connection is
active. By default, Avaya IP Office Release sends out OPTIONS every 300 seconds. The rate at
which the messages are sent is determined by the combination of the Binding Refresh Time (in
seconds) set on the Network Topology tab in Section 5.2 and the SIP_OPTIONS_PERIOD
parameter (in minutes) that can be set on the Source Number tab of the noUser user. The
OPTIONS period is determined in the following manner:

e To use the default value, set Binding Refresh Time to 0 or 300. OPTIONS will
be sent at the 300 second frequency.

e To establish a period of less than 300 seconds, do not define the SIP_OPTIONS_PERIOD
parameter and set the Binding Refresh Time to a value less than 300 seconds. The
OPTIONS message period will be equal to the Binding Refresh Time setting.

e To establish a period greater than 300 seconds, a SIP_OPTIONS_PERIOD parameter
must be defined. The Binding Refresh Time must be set to a value greater than 300
seconds. The OPTIONS message period will be the smaller of the Binding Refresh Time
and the SIP_OPTIONS_PERIOD settings.

To configure the SIP_OPTIONS_PERIOD parameter, navigate to User = noUser in the
Navigation Pane. Select the Source Numbers tab in the Details Pane. Click the Add button.

#- & BOOTP(2) -
+-¢7 Operator (3)
(=% Jersey City

Menu Programming | Mobility | Group Membership | Announcements | SIP Personal Directory
User | Voicemail | DND | Short Codes | Source Numbers | Telephony | Forwarding | Dial In | Yoice Recording | Button Programming

#- System (1) Source Number
+ 17 Line (6)
# <= Control Unit {2) Remove
[+ -4 Extension (16)
=@ User(18) Edit...
g Molser

f RemoteManager
251 Allan 9630

& 201 Extn201

| 202 Extn202

| 203 Extn203

| 204 Extn204

| 205 Extn20S
206 Extn206

& 207 Extn207

& 203 Extn208

| 252 James 1616
e 258 Jim 1120E
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At the bottom of the Details Pane, the Source Number field will appear. Enter
SIP_OPTIONS_PERIOD=X, where X is the desired value in minutes. Click OK.

Mew Source Number

Source Number |SIP_OPTIONS_PERIOD=6

The SIP_OPTIONS_PERIOD parameter will appear in the list of Source Numbers as shown
below. Click OK at the bottom of the screen (not shown).

ﬁ NoUser: * e -9 | X | v|<]|>

Menu Programming | Mobility | Group Membership | Announcements | SIP Personal Directory

User | Yoicemail | DND | Short Codes? Source Mumbers :Telephony Forwarding || Dial In | Voice Recording || Button Programming |

Source Mumber
|

| SIP_OPTIONS_PERIOD=6 [

Remove

Edit...

For the compliance test, an OPTIONS period of 60 seconds was desired. The Binding Refresh
Time was set to 60 seconds in Section 5.2. There was no need to define
SIP_OPTIONS_PERIOD.
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5.10. Privacy/Anonymous Calls

For outbound calls with privacy (anonymous) enabled, Avaya IP Office will replace the calling party
number in the From and Contact headers of the SIP INVITE message with “anonymous”. Avaya IP
Office can be configured to use the P-Preferred-lIdentity (PPI) or P-Asserted-ldentity (PAI) header to
pass the actual calling party information for authentication and billing. By default, Avaya IP Office
uses PPI for privacy.

To configure Avaya IP Office to use PAI for privacy calls, select NoUser under User in the
Navigation Pane, then select the Source Numbers tab in the Details Pane as shown in the first
screen in Section 5.9. Click the Add button.

At the bottom of the Details Pane, the Source Number field will appear. Enter
SIP_USE_PAI_FOR_PRIVACY. Click OK.

Mew Source Murber
K

Source Number SIP_USE_PAI_FOR_PRIVACY

The SIP_USE_PAI_FOR_PRIVACY parameter will appear in the list of Source Numbers as
shown below. Click OK at the bottom of the screen (not shown).

NoUser: * B - X wl<]|=

Menu Programming | Mobility | Phone Manager Options | Hunt Group Membership | Announcements | SIP Personal Directory

User | Voicemail | DND ShortCodes | Source Mumbers | Telsphony | Forwarding | Dial In || Yoice Recording | Butkon Programming

SIP_IUSE_PAL_FOR_PRIVACZY
Remove
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5.11. Save Configuration

Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.

The following Save Configuration screen will appear, with either Merge or Immediate selected,
based on the nature of the configuration changes made since the last save. Note that clicking OK
may cause a service disruption. Click OK to proceed.

Save Configuration

IP Office Settings

(%) Merge
() Immediate
() When Free
) Timed

Reboot Time

Call Barring

Jersey City

Configuration Reboot Mode

| o

J [ Cancel

Help ]

J

6. IntelePeer SIP Trunking Configuration

IntelePeer is responsible for the configuration of its SIP Trunking service. The customer will need to
provide the IP address used to reach the Avaya IP Office at the business site. IntelePeer will provide
the customer the necessary information to configure the Avaya IP Office SIP connection to

IntelePeer including:

e Network edge IP address of the IntelePeer SIP Trunking service.
e Transport and port for the IntelePeer SIP Trunking connection to the Avaya IP Office at the

business site.

e DID numbers to assign to users at the business site.

e Supported codecs and their preference order.
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7. Verification Steps

This section provides verification steps that may be performed in the field to verify that the solution
is configured properly

7.1. System Status

Use the Avaya IP Office System Status application to verify the SIP Line channels state and to check
alarms:

e Launch the application from Start = Programs = IP Office = System Status on the
Avaya IP Office Manager PC. Select the SIP Line under Trunks from the left pane. In the
Status tab in the right pane, verify the Current State is Idle for channels where no active
calls are currently in session; the state should be Connected for channels engaged in active
calls.

#ivaya IP Office System Status - Jersey City (10.32.128.30) - IP500 ¥2 9.0.1.0 build 845 M=1E3

IP Office System Status

Help Snapshot LogOff Exit About

Status | Utilization Summary Alarms

B System
B & Alarms (1)
K Extensions (12)

SIP Trunk Summary

B Trunks (6)
Lines:1-4 Peer Domain Name: 192.168.96.231
’_ ; d Resolved Address: 192.168.123.104
Act:\_:ec:.::s Line Number: 17
It Rasolrces Number of Administered Channels: 10
K Voicemail Number of Channels in Use: 2
KX IP Hetworking Administered Compression: G711 Mu, G729 A
Locations Silence Suppression: OFFf
Layer 4 Protocol: UDP
SIP Trunk Channel Licenses: Unlimited . 1%
SIP Trunk Channel Licenses in Use: 2

SIP Device Features:

Current Time in R.. Codec Connection  C. Other Party on Call Direction R. Receive ) Transmit Transmit
§ State Type of Call Jitter acke... Jitter Packet... |
1 1 14 | Connected | 00:02:09 |...| G711 Mu | RTPRelay |...|Extn 256, Tony 9611 Incoming
2 0 | 15 |Connected | 00:01:51 |...| G711 Mu | RTP Relay Extn 258, Jim 1120E Outgoing
3 Idle 1 day 20...
4 Idle 1 day 20...
S Idle 1 day 20...
6 Idle 1 day 20...
7 Idle 1 day 20...
8 Idle 1 day 20...
9 Idle 1 day 20...
10 Idle 1 day 20...
e et —————————————————————————————————————————————————]
Trace [ Trace All ] [ Pause ] [ Ping ] Call Details Print... ] [ Save As...
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e Select the Alarms tab and verify that no alarms are active on the SIP Line.

Status  Utilization Summary Alarms

Alarms for Line: 17 SIP 192.168.96.231

Last Date Of Error Qccurrences Error Description
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7.2. Monitor

The Monitor application can be used to monitor and troubleshoot Avaya IP Office. Monitor can be
accessed from Start = Programs > IP Office = Monitor on the Avaya IP Office Manager PC.
The application allows monitored information to be customized. To customize, select Filters >
Trace Options... as shown below:

£ Avaya IP Office SysMonitor - [STOPPED] Monitoring 10.32.128.30 ; Log Settings - C:\Documents and Settingsk...\sip... Q@@
File Edit View BEEEN Status Help

2R »E |Trace Options ... Cbrl+T | &*
I"i Send To Syslog

The following screen shows the SIP tab of trace options. In this example, Standard SIP Events and
the SIP Rx and SIP Tx boxes are checked.

All Settings @

T | YPN | WAN | SCN | Jade |
ATM | cal | DTE | EConf | FrameRelay | GOD | H323 | Interface |
ISDN | Key/Lamp | Directory | Media | PPP | B2 | Routing | Services SIP |System|

Events

WV Sip {m [~ STUN [~ SIP Dect
Packets

[~ SIP Reg/Opt Rx [~ SIP Misc Rz

[~ SIP Reg/Opt Tx [ SIP Misc Tx

[~ SIPCalR [~ Cm Naotify Rz

[~ Cm Notify Tx
v SipRx IP Filter (nnh.nnn.nhn.nnn)
V SipTx [
Default AIII Clear All | Tab CIearAHl Tab SelAII‘ oK Cancel
Save File I Load File l Load Partial File | Select File |
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8. Conclusion

The IntelePeer SIP Trunking service passed compliance testing. These Application Notes describe
the procedures required to configure the connectivity between Avaya IP Office and IntelePeer SIP
Trunking as shown in Figure 1. Test results and observations are noted in Section 2.2.

9. Additional References

[1] IP Office Documentation Library, Release 9.0, Documentation number 15-604278 Issue 1,
September 2013
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[3] Avaya IP Office 9.0 Installing IP500/IP500 V2, Document number15-601042 Issue 28j, January
2014.

[4] Avaya IP Office 9.0 Administering Voicemail Pro, Document number15-601063 Issue 9.01.0,
September 2013.

[5] Avaya IP Office Manager Release 9.0, Document number15-601011 Issue 9.02.0, January 2014.

[6] Avaya IP Office 9.0 Using System Status, Document number15-601758 Issue 09c, August 2013.

[7] Avaya IP Office 9.0 Using IP Office System Monitor, Document Number 15-601019, Issue 05c,
August 2013.

[8] Avaya IP Office 9.0 H.323 Telephone Installation, Document Number 15-601046, Issue 18b,
August 2013.

[9] Avaya IP Office 9.0 SIP Extension Installation, Issue 3c, August 2013.

Additional IP Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/.

Product documentation for the IntelePeer SIP Trunking is available from IntelePeer. See Section 2.3
on how to contact IntelePeer.
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